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Personal Appeal to Not Distribute 
I’ve made this workbook available to those who buy my online course, but I’m an individual 
running a small business. Please do not share or distribute this workbook in any way. I was 
going to lock this workbook down so that it couldn’t be downloaded at all but decided 
against it in the 11th hour to better serve those who pay for the course. I trust you’ll do the 
right thing and enjoy the benefits of your purchase. 

Purpose of This Workbook 
I subscribe to the Justin Cutroni method of doing a Google Analytics course: Live is better 
than following a workbook! 

 

 

The only purpose of this workbook is to serve as a reference that you can use to look up 
tips and techniques covered in the seminar. I will try my best to keep it to just the 
essentials. 
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Google Analytics Interface 

Deconstructing a Report 
If you see a Customize option at the top of any standard report, you can select it to see 
how it is built. This is a great way to learn how to build your own. 

 

Create Your Own Custom Report 
Custom reports provide you with much more flexibility than you get with standard reports. 
You can choose exactly which dimensions, metrics, filters, etc. you want to be in your 
report.  

Custom Reports as a Training Tool 

Playing with custom reports is also a great way to learn which dimensions and metrics work 
together. For example, if you choose Visitors as a metric, the number of dimensions you can 
choose from will be reduced significantly.   

How to Create One 

To create a custom report, choose Customization at the top of any report, then the New 
Custom Report button. You will be given a variety of options: 
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General Information 

Title: Give your report an intuitive title 

Report Content 

Report tab: Break your reports into different tabs to satisfy different audiences 

Caveat: Any filters you apply carry across all of the tabs. This nuance (more like nuisance) 
really limits the usefulness of report tabs. <kicks dirt> 

Type:  

• Explorer: These are the model for the standard reports in Google Analytics. If 
dimension is a link, you can “drill down” to the next dimension, e.g., Medium > 
Source > Landing Page (screenshot: bit.ly/drilldown).  

• Flat Table: Great for generating pivot table-friendly reports. I wrote a blog post on 
how to do this here: bit.ly/pt-reports.  

• Map Overlay: Just like you see under Audience > Geo > Location. 

Metric Groups 

This is where you add metrics (e.g., visits, bounce rate, etc.). You can also group your 
metrics like you see in standard reports. 

 

Dimension Drilldowns 

The heading for this section assumed you’re creating an explorer-style report. If you’re 
creating a flat table-style report, you won’t be able to drill down through your dimensions. 
In fact, you only get two. (Lame.) If you’re creating an explorer-style report, you get up to 
five.  

If you’re creating an explorer-style report and you have another layer of dimensions below 
what you have selected, it will be clickable; if not, it will be static text. 
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Pro Tip: To be able to isolate a single dimension, choose it twice. For example, choosing 
Country/Territory > Region > City > City, you will be able to select a city to get just the 
metrics for that one city.  

 

Look at the New vs Returning report (Audience > Behavior) to see an example of this inside 
the interface. 

To get a full list of dimensions and metrics, go to bit.ly/api-help.  

Filters 

This is where you can create filters for your report. For example, if you want to just analyze 
organic traffic you would create a filter that includes traffic if the medium (or traffic type) 
matches organic. As you can see in the screenshot below, Google Analytics will offer 
suggestions. 

 

 

You can also use regular expressions (more on regex in the next session). Just choose 
Regex from the drop-down that defaults to Exact. The example below will give me only 
visits that are tagged ppc or cpc and come from the United States or Canada.  
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Notice how I have those same dimensions selected in the Dimension Drilldown section. You 
want to do that when you first set up a filter, to make sure you’re getting what you want. I 
will also set my filter(s) to Exclude to make sure I’m not leaving anything behind that should 
be included.  

But once you’ve tested your filter, you can delete them from the Dimension Drilldown 
section. No need to drill down needlessly in your report. So if I wanted to look at the 
performance of my paid search landing pages from this segment, I’d delete County/Territory 
and Medium and select Landing Page. 

Here’s another example of a filter that captures only referral traffic from Google sites: 
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Note: The caret ( ^ ) says the source name has to start with google. This would be filter out 
referrals like allaboutgoogle.com.  

Views 

Google Analytics allows you to make your custom report available to as many views (fka 
profiles) as you have access to. This is very convenient if you manage multiple views. 

Learn More with My Video Tutorial 

You can view a video tutorial I did on creating custom reports here: bit.ly/custom-ga-
reports.   
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Notes: Custom Reports 
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Understanding the Terminology 

Learning what everything means in Google Analytics can be intimidating. There’s a lot of 
geek speak.  

Here are a few terms I will be using throughout the course that you should be familiar with. 
These definitions are simplified by design. You don’t have to understand all of the nuances 
to get started in Google Analytics. 

Metric: Anything that can be measured with a number 

Dimension: How you want the report to drill down 

 

 

 

Primary Dimension:  The main dimension in a particular view of the interface 

Secondary Dimension:  A way to slice and dice your first dimension 
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URI: The part of a URL sans the domain, e.g., /blog/ (as opposed to 
www.annielytics.com/blog/) 

Path: Another word for URI, e.g., entrance page path, referral path 

Hostname: The subdomain of the site with your tracking code (for my site all would be 
www.annielytics.com because I only have one subdomain; for a site with multiple 
subdomains, they might be www.example.com, blog.example.com, store.example.com) 

Source: The subdomain of the referring site  

Pro Tip: If you want to know the full URL, concatenate source + referral path for visits from 
other sites or hostname + page (or pagePath in the API) for pages on your own site 

Bounce Rate: Percentage of visitors who leave the site after viewing only one page 

View: Google’s new name for a profile 

Regex: Short for regular expression, it’s a sequence of characters that forms a search 
pattern, mainly for use in pattern matching with strings. (I wrote a post for newbies on how to 
use them in GA: bit.ly/regex-for-newbies.) 

(none): You’ll see this under the Acquisition report quite a bit. It just means direct traffic. 

(not set): You’ll see this most frequently with filtered views (previously called profiles). 
With a filtered profile, data gets lobbed off according to your profile’s filters. So, for 
example, if you have a separate profile for each of your subdomains (boo) and a visitor 
visits the subdomain for the view you’re looking at but then moves to another subdomain 
and returns to the original subdomain, the previous page will show up as (not set) because 
all of the data for the second subdomain is filtered out. 

(not provided): If a search engine (like Google) has encrypted searches, the specific 
keywords a visitor searches for will not be passed on to the site’s analytics account. The 
keyword shows up as (not provided). Do not even bother analyzing keyword data from 
organic search reports. 

Standard Reports 
This section is mostly a live demo of the standard reports Google Analytics offers. 

There are a couple notes I’ll point though, for posterity’s sake. 

Plot Rows 

Google Analytics gives you the ability to choose specific rows to view on the timeline. To do 
this, select the check box to the left of each line item you want to display (up to six) and 
click the Plot Rows button. 
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Get More Rows 

Google Analytics will allow you to export up to 5,000 rows. But you can get more with a 
hack: Increase the number of rows to 25 > look for explorer-table.rowCount%3D25/ at the 
end of the URL > change the 25 to the number of rows you need.  

Sampling 

Sampling Defined 

Sampling is the selection of a subset of from within a statistical population to estimate 
characteristics of the whole population. 

Causes  

Google Analytics starts sampling at 250,000 visits in a property (not in a view/profile). This 
is one reason it’s not a good idea to put more than one website in a single property. 

How to Detect It 

Look for this yellow alert box: 

 

 

This pops up if there are more than 250,000 visits to the property. To find out how many 
visits your property has received for the selected time period, go to your dashboard by 
clicking the Home link at the top of any report.  

For my site, the account is Pied Piper Interactive (my umbrella company), the property is 
http://annielytics.com, and the views (formerly known as profiles) are Annielytics and 
Annielytics – Raw. To get to this page, click the Home icon in the top navigation bar.  
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If you have multiple sites set up under one property, you will need to add up the visits from 
each of the sites to get the total number of visits. (Visits for different views of a single site 
don’t count against that threshold.) 

If you only have one website in a property (as you should), you can also see overall visits 
for a date range from the Overview report under Audience or Acquisition. 

 

How Much Is Too Much 

Rule of thumb: data sampling = confidence in the data 

• 20% of visits sampled, 20% confidence in the data 
• 80% of visits sampled, 80% confidence in the data 
• 3% of visits sampled, throwing spaghetti against a wall might be more accurate 

How to Minimize Its Impact 

Double the Threshold  

Google Analytics will allow you to bump the threshold up to 500,000 visits with a hidden 
slider, but it’s not apparent how to do that. To access the slider, click the grid icon above 
the warning and move the dot all the way to the right. This will double the percentage that 
you originally saw, so if Google Analytics was previously only processing 20% of your traffic, 
it will recalculate using 40%.  
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Obviously, any sampling rates greater than 50% will result in the eradication of sampling for 
the time period you have chosen once you’ve moved the slider. So you need to train 
yourself, like Pavlov’s dog, to move the slider any time you see that yellow warning box. 

Reduce Date Range 

Reducing the date range will reduce the number of visits, getting you closer to 500,000. 

Use Standard Reports 

The standard reports in Google Analytics aren’t subject to sampling. Custom reports are. 
However, if you apply an advanced segment to a standard report, you’ll get sampling.  

It’s better to apply report filters over using advanced segments for this reason. For example, 
here is a report that isolates (not provided) traffic using an advanced segment: 

 

 

And here’s one that uses a report filter: 
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Google Analytics Premium 

Premium gives you up to 100 million visits before Google Analytics starts sampling.  

Google Analytics API 

By using the API, you can import all of your Google Analytics data into a database to 
retrieve it from there. Using the API alone won’t solve your sampling issue, but it does give 
you the opportunity to pull the data you need to use later in your own system. 

Analytics Canvas 

Analytics Canvas (which we’ll be learning more about on Day 3) has a functionality that 
reduces sampling significantly. You can’t use this solution for visitor-level metrics since the 
data gets scrambled, but it works beautifully on session- and hit-level analysis. 
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Notes: Sampling 
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Advanced Segments 

Caveat 

As mentioned in the section on Sampling, advanced segments cause sampling in larger 
sites, so I’m very cautious with them. As a general rule, I mostly use advanced segments 
for forensic analysis. I use filters for reporting.  

When to Use Advanced Segments 

1. When your property receives well under the 500,000 visits allotted before sampling 
kicks in. 

2. When you need to export a segment of visits or visitors you can’t get from one 
report. 

For example, when iOS 6 started reporting organic traffic as direct, I added a chart 
to clients’ reporting dashboards that compared direct to organic for traffic coming 
from iOS devices to account for the sudden drop in organic traffic. I couldn’t have 
gotten that data with report filters. With a report filter, I could look at just organic 
traffic from iOS devices or direct traffic; I can’t compare their performance in a 
timeline like you see below. (Read more about how I did it here: bit.ly/ios-mess.)  

 

 

Other good examples: 

• Analyze traffic landing on blog pages vs traffic landing on commercial pages.  
• Combine social referrals and campaigns for each social network — e.g., 

create a Facebook segment that stitches together traffic from facebook.com 
and m.facebook.com with campaign traffic you’ve tagged (more on that in 
the Campaign Tagging section). 
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• Compare visitors who made at least one goal conversion vs those who 
generated revenue vs those who didn’t convert at all. 

• Compare branded vs non-branded PPC keywords. 
3. When you want to quickly apply qualifiers to a variety of reports. Report filters are 

tied to a particular report. Segments can be applied to all reports. 
4. When you want to segment by visitor behavior. Examples might be visitors who have 

spent at least $100 on your site, visitors who have visited your site at least x times, 
date of a visitor’s first visit, etc. 

Gallery 

Take advantage of Google Analytics’ impressive gallery of segments, custom reports, and 
dashboards! 

Report Filters 

What They Do 

Report filters allow you to filter a particular report using whatever dimensions and metrics 
are present in the report. As mentioned in the Sampling section, report filters don’t cause 
sampling like advanced segments do.  

What It Is Not 

Report filters are not the same thing as view (profile) filters. View filters are applied to the 
entire view and are often misused. View profiles are outside the scope of this course. 

Regex Heaven 

If you’re not familiar with regex (short for regular expressions), I wrote a post that is 
newbie friendly (bit.ly/regex-for-newbies). Report filters are sensitive to regex. You apply 
them clicking the advanced link to the right of the filter field, selecting the dimension or 
metric you want to filter by, choosing Matching RegExp from the drop-down menu, then 
entering your regular expression. 
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Multi-Channel Funnels 

What Are They 

Multi-channel funnels are the best thing to happen to Google Analytics in a long time. The 
reason is they show much truer values for how much a channel (or medium or source or 
whatever) is generating than what you get from Google Analytics’ standard reports. The 
reason is Google Analytics’ standard reporting awards conversions using last-click 
interactions. Multi-channel funnels look at last-click, first-click, and all other assists to a 
conversion. 

A Few Notes 

• First-click interactions are a subset (or type) of assists. 
• The lookback window is set by default to 30 days. I always dial it up to the full 90 

days allowed. (The API doesn’t allow you to change this as of the publishing date of 
this workbook.) When I asked Justin Cutroni (Google Analytics evangelist) about 
this, he said they’re considering adding it. (Translation: “Oh crap! We forgot to add 
that to the API? Let me submit a work order to the engineers.”) 

• In standard reports, if a visitor visits the site via a campaign and then returns as a 
direct visit, the campaign inherits credit for the conversion. Not so with multi-
channel funnels. Direct is awarded credit for the conversion. Because of this revenue 
numbers between regular reports and multi-channel funnel reports oftentimes won’t 
match. As you might imagine, for most sites, direct is credited with more 
conversions in the Multi-Channel Funnels model. 

How Channels Are Defined 

This is how Google has defined each of the default channels: 
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Source: bit.ly/channel-definitions  

To see these in Google Analytics take these steps: 

1. In the Assisted Conversions or Top Conversion Paths report (under Conversions > 
Multi-Channel Funnels), click Channel Groupings and then select Copy MCF Channel 
Grouping template. (You’re not going to actually save the copy.) 
 

 
 

2. Click the pencil icon for the channel you want to check out. 
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3. Voilà.  
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How to Customize Default Channel Groupings 

You will need to do this if you’ve been tagging social traffic as anything other than one of 
the acceptable tags you see in the above screenshot. I recommend using 
utm_medium=social for simplicity’s sake.  

Warning: There are social management tools like SocialFlow that mistag links. (Buffer used 
to be another offender.) So if you look at the mediums reporting in your Campaigns report 
(Acquisition > Campaigns > Primary Dimension: Medium) and see various sources, like the 
screenshot below, you will need to clean up your channel groupings (and fix your tagging 
strategy): 

 

 

More on why these aren’t mediums in the next section. 

To redefine how a channel grouping is defined, you’ll need to take these steps: 

1. Click Admin > Choose the Property and View. 
2. Click the Actions button next to Default Channel Grouping and choose Edit. 
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3. Click AND/OR to add new rules. 

Create Your Own 

You can create your own channel groupings (in the Assisted Conversions and Top 
Conversion Paths reports), but you can only access the default channel grouping via the API 
(at the time of publication). So if you want to use the API, you’ll need to modify the default 
channel grouping as described above. 
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Notes: Multi-Channel Funnels 
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Campaign Tagging 
If you’re running marketing campaigns, campaign tagging is absolutely critical. What 
campaign tagging allows you to do is set the source, medium, and campaign name for a 
marketing campaign. Although term an content are primarily for tagging your paid 
campaigns, you can use them for regular marketing campaigns to get more data. For 
example, I sometimes use content to capture banner sizes or the position of a link in an 
email (body, image, footer, etc.)  

Campaign Parameters 

Medium 

What It Is 

Think of medium as a bucket. You want these buckets to be pretty big. In Google Analytics 
you can view the mediums your site is getting traffic from by going to Acquisition > All 
Traffic and choosing Medium as your primary dimension. If you see more than 10 line items, 
you may be tagging mediums incorrectly.  

How It’s Collected 

When Google Analytics drops a cookie in a visitor’s browser, it will collect medium data 
automatically, as long as the user has cookies enabled. The standard mediums are:  

• organic 
• (none) 
• referral 
• cpc (if you’re using AdWords and have enabled auto tagging) 

If you don’t tag links and no one else tags links that point to your site, these are the 
mediums you’ll see. (And you’ll only see cpc if you’re running AdWords.) 

However, Google gives you the ability to overwrite the cookie with what you want the 
medium (or source) to be. But with great power comes great responsibility, grasshoppah. 
I’ve seen site owners completely trash their analytics profile by misusing campaign tagging. 
You can read a cautionary tale here: bit.ly/trash-your-data.  

Good Mediums to Use 

If you’re putting links to your site on social media channels, email, banner ads, etc. it’s 
critical that you tag these links. Here are some good mediums to use: 

• social 
• email 
• feed 
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• banner 
• cpc (or ppc) 
• display 
• affiliate 
• ebook 
• tv 
• print 
• billboard 
• partner 
• radio 
• qr code 
• widget 

 

Tagging for Offsite Campaigns 

But what if your link isn’t on a website? What if it’s on a billboard, for example? That’s 
where vanity URLs come into play. Let’s say you’re running a sale on funky shoes. (Imagine 
that!) You could create a vanity URL (let’s say yousocray.com) and 301 redirect it to a 
landing page on your site that’s tagged:  

www.annielytics.com/?utm_medium=billboard&utm_source=main+st&utm_campaign=socray  

As always, test this before launching your campaign to make sure nothing gets mangled in 
the redirect. 

Don’t Be a Statistic 

The most common mistake I see with social tagging is tagging the network — e.g., Twitter 
and Facebook — as the medium. They are not mediums; they are sources. Getting this 
wrong will wreak havoc in your social reports AND the glorious Channels report (under 
Acquisition), as mentioned in the Multi-Channel Funnels section. Your precious social visits 
will show up as referrals. 
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Pro Tip: Google launched the Channels report July 25, 2013. If you run this report for a date 
range that predates this date, your data will show up as (not set). If you adjust your date 
range and you still see (not set), click on (not set) to drill down to see the sources driving 
this traffic and modify your Default Channel Groupings. (Learn how in the How to Customize 
Default Channels section of this workbook (under Google Analytics Interface > Multi-channel 
Funnels).   

Source 

Source is simply the site the link lives on. So if you put a link out on Twitter, the source 
should be twitter.com; if it’s on Facebook, facebook.com; if it’s a banner on a partner site, it 
should be the domain of the site it’s on.  

Look at how sources show up in your referral reports (Acquisition > All Referrals). Your 
tagged sources should match those.  
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Warning about Google+ 

If you want links you share on Google+ to show up properly, either use plus.url.google.com 
(Google’s default) or plus.google.com as the source. Either of these will cause visits from 
tagged URLs to show up in other important reports, such as the Network Referrals report 
(Social > Network Referrals) and the Visitors Flow report (Social > Visitors Flow). 

Email Tagging Conundrum 

Email is a little different. Because these links don’t reside on a site per se, use your 
discretion. I’ve most commonly seen marketers tag them as internal or the name of the 
email service they use (such as marketo). I wouldn’t use your site (e.g., annielytics.com) as 
the source though because it will look like you have self-referrals (which you can check for 
by looking for your own domain in the All Referrals report). 
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When links are tagged strategically, your ability to segment will be a thing of legends. 
Sources should fit neatly into medium “buckets” and look something like this: 

 

Campaign 

The campaign name is simply whatever you name your campaign. Examples might be 
bogo+sale, 2014-02+newsletter, and new+member+email.  

A few things to keep in mind: 

• Don’t make them too specific. If you send out a daily email, don’t make the 
campaign name specific to each day. It makes roll-up reporting more challenging.  

• Ideally, you should use campaign names that span different mediums. For example, 
if you run a BOGO sale using the campaign name bogo+sale and promote it on 
Twitter, Facebook, Pinterest, email, CPC, and a banner for your affiliates, they 
should all use the same campaign name. This way you can compare how your 
promotion did across marketing channels (mediums) and across sites (sources).    

Tagging Strategies 

There are a few tips I’ll pass on from the trenches: 

• Be consistent. Keep a record of the tags you use and use the naming conventions 
consistently.  

• Use a tool to tag. You can use Google’s URL builder (bitly.com/url-builder) to create 
them one by one. Or you can use this Google Spreadsheet I created to auto tag your 
links: bit.ly/utm-tagging. I include a tab with tips and comments throughout the doc. 
Look for the orange dots in the upper-right corners of cells. 
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• Use lowercase. Google Analytics is case sensitive, so visits to 
utm_campaign=BOGO+sale will show up as a separate line item from 
utm_campaign=bogo+sale, wreaking havoc in your reports. 

• Separate words with + signs. These will translate into spaces in your Google 
Analytics reports. 

Campaign Reports 

You will find campaign traffic under Acquisition > Campaigns. The default primary 
dimension is Campaign, but feel free to choose Source and Medium and even use secondary 
dimensions. Slice and dice this data until the cows come home. 
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Notes: Campaign Tagging 
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Excellent Analytics 

Download 
You can download Excellent Analytics here: bit.ly/download-ea (PC swim only)  

Why Excellent Analytics 
1. It’s free. Hard to beat that. 
2. It integrates right into Excel, which is perfect for dashboards. 
3. It doesn’t preformat the data, so you can brand the data according to your own 

branding. (That’s why I didn’t like Data Grabber or Next Analytics.) 
4. It has an interface. You don’t have to piecemeal the query together, like I used to 

have to when I used Google Spreadsheets. 
 

 
 

5. The queries can be easily edited in the interface. With some API tools, if you want to 
modify the data later on, you have to edit the actual query. 

6. It’s a great way to learn about the dimensions and metrics offered in the API. 
7. It doesn’t use VBA, so you don’t have to save workbooks as macro-enabled. One 

tool used VBA and wiped out all of my visualizations I had built when I refreshed the 
data, which wrecked my day. I’m not a big fan of tools that wreck my day. 

8. Did I mention it’s free? 

The Bad News 
1. There’s no technical support. If you run into issues, there’s a Quora group with 

Excellent Analytics enthusiasts (bit.ly/ea-quora).  
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2. The company that so generously shared it with the world (Ampliofy) doesn’t 
maintain it, so it hasn’t been updated in years.  

3. It’s buggy. The Dimensions functionality has a bug that sometimes doesn’t allow you 
to change the mediums you’ve selected when you try to update the query after 
running it. When you go to collapse that menu, it just won’t collapse, which means 
you can’t finish the query. Take my word for it: If this happens, just abort mission 
and start your query over. I’ve never been able to get it to collapse once it’s gotten 
stuck. I haven’t run into this bug since I started using Windows 8 (blech), but I also 
don’t use it as frequently as I used to (because I keep nudging clients to upgrade to 
Analytics Canvas, which makes my heart sing). 

4. You only get up to 10,000 rows of data. So that doesn’t allow for a lot of 
segmentation in a single query. Unless you have a small site, are only reporting on 
high-level metrics, or focus on top X reports (e.g., top 10 landing pages), you’re 
going to hit this limit pretty fast. 

Tutorial 
I wrote a tutorial on the Search Engine Land site that walks you through how to use 
Excellent Analytics in case you get stuck: bit.ly/ea-tutorial.  
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Notes: Excellent Analytics 
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Intermediate Excel 

Quick Access Toolbar 
I can’t live without the Quick Access Toolbar (QAT). Unfortunately, it’s not offered on the 
Mac. On the PC, it shows up above the Ribbon by default. I move it below to make it more 
accessible. To move it, click the down-facing arrow to the far-right of the toolbar and 
choose Show Below the Ribbon. 

You can add any element on the Ribbon to the QAT by right-clicking and choosing Add to 
Quick Access Toolbar. 

 

To reorder items on the QAT, click the down-facing arrow again, and select More 
Commands. From the Excel Options dialog, you can add, remove, and sort items. 

Navigating the Interface 

Enable Developer Ribbon 

To do some of the things we’ll be doing in this seminar, you’ll need the Developer ribbon. 
To enable it on a PC, go to File > Options > Customize Ribbon > Customize the Ribbons > 
Main Tabs: Developer. On a Mac, go to Excel > Preferences > Sharing and Privacy > Ribbon 
> Customize > Check Developer. 

Hide/Unhide Sheets 

When I’m finished all of my mad computing, I hide the sheets with all the ugly, unformatted 
data. It’s a preference thing. I like to display the data users will find most helpful but then 
add links to the ugly data. To hide a worksheet, right-click on any tab at the bottom of a 
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worksheet and choose Hide. If you suspect a workbook might have hidden worksheets, you 
can right-click any of the tabs and see if the Unhide option is available. If it is, you can 
unhide worksheets.   

Hide/Unhide Rows and Columns 

To hide a row or column, select the row(s) and/or column(s) by dragging over them or Ctrl-
clicking (Mac: Command-clicking) them. Then right-click and choose Hide.  

To unhide a row or column, click-and-drag the rows and columns that surround the hidden 
rows/columns, then right-click and choose Unhide. 

Insert/Delete Rows and Columns 

To insert a row or column, select the row or column you want to push down or over, then 
right-click and choose Insert. If you choose multiple row or columns, Excel will push all of 
them down and over, respectively.  

So in the example below, columns BE to BH will become blank columns, and everything to 
the right of column BE will be pushed to the right four columns. 

 

Viewing All Sheets 

If you have a large workbook with many worksheets, instead of scrolling to see more 
sheets, right-click on the arrows in the far-left corner of the status bar. An Activate dialog 
will pop up, allowing you to choose the sheet you want.  
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Navigating Data Sets 

Ctrl-Arrow (Mac: Command-Arrow): Move to the perimeter  

Ctrl-Shift-Arrow (Mac: Command-Shift-Arrow): Select from current cell to the 
perimeter of a data set 

Ctrl-A (Mac: Command-A): When any cell in a data set is selected, this selects the entire 
data set. If you’re in a formatted table, the first time will select the data; pressing it again 
will include headings. 

Decluttering Worksheets 

Gridlines 

Gridlines are fine in raw data and calculated worksheets, but they should never be selected 
for dashboard worksheets (or any presentation worksheets). Learn to hate them! If you 
need visual guides for tabular data (data in tables), formatted tables come with lines. 

To turn these off, go to View > Show (Mac: Layout > View) and deselect the check box. 

Headings 

Headings are the kissing cousin of gridlines — fine for data worksheets but should be left 
out of dashboards. They add visual noise. The one exception is if people using your 
dashboard need to adjust the width of columns and rows. You can’t do this without 
headings being visible. Again, that’s why I don’t mind them being visible in data worksheets, 
but a dashboard is going to look a cleaner without them. 
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Margin 

I don’t like that Excel doesn’t have any margin built into spreadsheets. Whitespace is an 
import design element in dashboards, as with anything. So I’m in the habit of using Column 
A for a makeshift margin. I never put anything in that column. I set the width to 1 by 
pressing Alt-O-C-W on a PC or pulling the borders between rows/columns until the desired 
height/width. 

Auto Adjust Widths 

If you want to adjust a column or row to fit whatever is in the cell, just select the columns 
or rows you want to adjust and double-click on one of the borders. They will all adjust. 
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Planning Your Dashboard 

Requirement Gathering 

It’s very important to find out what KPIs are important to decision makers. I like to ask 
clients what keeps them up at night. Those are really the most important KPIs. Once I have 
a general idea, I’ll send out a Google Form to ask more questions from all of the involved 
parties. To learn more about Google Forms, visit bit.ly/google-form-tutorial.  

Mockup 

You can create the mockup using a wireframing tool like Balsamiq or use plain old pencil 
and paper. I usually end up creating at least three of these before I am ready to move to 
the next step. 

Organizing Data 

Everyone has their own system for organizing data, and there’s no right or wrong way. 
However, I’ve found that my method helps keep everything organized and scalable. 
Essentially, I divide my dashboard into five main elements: 

Dashboard 

This is one sheet and contains only your sexy data: charts, branded tables, buttons, 
scorecards, etc. Here’s an example of one of the dashboards from this course: 

 

Oh. Hey, sexy data … Umm you come around here often?  
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Raw Data 

You know those heavily Photoshopped before and after images in chicks’ magazines? Yeah, 
your Raw Data sheet is the before pic. No pretty data is allowed in here — only ugly, 
unformatted, unloved (for now!) raw data. 

 

 
Calculated Data 

This sheet is the salon. This is where all the data au naturale goes to get pretty. We nip, 
tuck, make sure outfits match shoes, and send it on its way to its ultimate destination: The 
Dashboard (oooo ahhh).  

Seriously, what you’ll see on this sheet, if you just show formulas (PC: Ctrl-` / Mac:  
Command-`) are formulas everywhere a la … 
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Data Map 

It’s important to give recipients who are using your dashboard or suckers employees who 
inherit it to be able to follow the logic. A data map — or index — helps toward that end. 
Data maps employee internal links to connect everything.  

 

Here are the steps I take to create internal links:  

1. Reference the cell you’re going to link to by entering an = sign in the, then find the 
item you want to link to in your workbook. Click the cell that contains the title (or a 
cell just above a chart, if the title is in the chart. Press Enter (Mac: Return) to 
commit. 

2. Remove the = sign to break the formula. Then copy what’s left. You’ll use this 
reference to create the link. Press Ctrl-Enter (Mac: Command-Enter) to commit the 
change and keep the current cell selected. 

3. To create an internal link in Excel, select the cell and press Ctrl-K (Mac: Command-
K), then choose Place in This Document from the Insert Hyperlink dialog. 

4. Where it says “Type the cell reference” paste your cell reference in. (It’s a total 
oversight that Excel doesn’t provide a cell selector here.) Then click OK. 
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To turn the Section titles on their axes, take these steps: 

1. Enter your text in the top cell. 
2. Select all the cells you want the text to be centered across and press Ctrl-1 (Mac: 

Command-1) to open the Format Cells dialog.  
3. Adjust the orientation to 90° (1) and choose Merge cells under Text control (2). 

 

4. Select the rows and adjust them to match the height of the other rows (right-click > 
Row Height). I usually wait until I’m finished, figure out the row with the greatest 
height and adjust the others to match. (If you click-and-hold on any of the 
separators between row headings, you’ll see the height.)  

5. To center the text vertically and horizontally, I selected the merged cell and chose 
the options below: 
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Updates/Notes Sheet 

If your dashboard has elements that need to be updated manually, you should add those 
into a sheet that will become a checklist for future reporting periods. Basically, the less 
thinking you have to do at reporting time, the better. When you’re finished with it, I 
recommend hiding it, so your recipients aren’t distracted by it.  

Format Bars 

I like to keep my data organized by using fills. They look like this: 
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Warning: Don’t use merge cells for these. If you need to add columns later, you won’t be 
able to. Instead, there’s a little-known formatting option called Center Across Selection. Use 
that. Your text will be centered, but you’ll still be able to insert and delete columns. To 
create these “bars” take the following steps: 

1. Select the cells you want to format and choose your fill and text colors. 
2. Enter your text into the active cell (which will be the first cell in the selection). 
3. With the cells still selected, press Ctrl-1 (Mac: Command-1) to pull up the Format 

Cells dialog. 
 

 
 

4. Choose Alignment > Text Alignment > Horizontal: Center Across Selection and Enter 
(Mac: Return). 
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Notes: Planning 
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Tables 
If there’s one task most marketers share it’s collecting and interpreting data. Being able to 
slice and dice the data to find actionable insights is key to effective analysis. 

Yet, one of the biggest mistakes marketers make is trying to wrangle static data instead of 
taking advantage of Excel’s table formatting, which basically turns your data range into an 
interactive database. I hope to rectify that injustice against innocent data. 

Get Started 

To get started, select any cell inside your data set, then choose Home > Styles > Format 
as Table (Mac: Tables > Table Styles). 

A ‘Format as Table’ menu will pop up. This will give you a drop-down of table formatting 
options.  
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Excel will auto-detect the perimeter of your table and populate the range.  

Sort & Filter 

The best benefit to formatting your data as a table, in my opinion, is the multiplicity of 
sort and filter options it affords. You can access these by clicking on any of the down-
facing triangles in the header row. 

If your column contains text you’ll see filter options specific to text, and if your data 
contains numbers, they will be tailored to numbers, as you can see in this comparison: 

 

Filter Options 

As the name suggests, the filter options hide rows based on the criteria you choose. No 
data is lost in this process. It’s just temporarily hidden to help you hone in on the data 
you’re trying to interpret. 

At any time, you can release these filters by choosing Clear Filter from [Heading] from 
the drop-down menu on a PC and the Clear Filter button on a Mac. 

With this example, I was able to filter out all of the branded keywords for Shoe Mania by 
using a combination filter, as you can see in the screenshot below. 
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One time I was trying to filter by all keywords that contained halloween, and it was no 
small task. People have no idea how to spell the word, and I had about 20 different 
variations and only two filters to work with. 

I was eventually able to capture all but a few with a “Contains” filter that employed both 
the ? and * wildcards. The result was h?l*en. 

That translates to, “I know it starts with an h and then could have any one letter after that 
(to capture the variations that use an o instead of an a). Then there’s an l, followed by a 
total free for all, finally wrapping up with an en at the end.” 

Then, I used another “Contains” filter that tacked an e at the end of all that, lassoing the 
few stragglers that were left. 

If you need to do more sophisticated filtering, I highly recommend using Excel’s 
advanced filters. I wrote a tutorial on how to use them, which includes a downloadable 
workbook. You can check it out here: bit.ly/adv-filters.  

Adding Rows and Columns 

You might say to yourself, “Hey, I can get all the same functionality by adding filters to 
the header row.” (Just select the cells that make up the header row and go to Data > 
Filter to do this.) I’ve seen examples where marketers will boldface the headers and add 
these filters. It’s pretty bourgeois when you can get fully formatted tables with the same 
number of clicks. 

However, one option you get with a formatted table that you won’t get by just adding 
filters is the flexibility in adding new columns or rows to your table. If you click just to the 
right or below the table and enter a value, the table will automatically expand to include 
the new row/column. This is a huge boon to charting because any chart built off a 
formatted table will automatically update when you add new rows or columns. 
Otherwise, you have to update them manually or create dynamic named ranges. (You’ll 
learn about that in the Dynamic Ranges section.) 
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Learn More 

To learn more about how to rock formatted tables in Excel, check out: bit.ly/table-
formatting.  
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Notes: Tables 
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Cell Formatting 

Standard Number Formatting 

You would think everyone would use number formatting; it’s so rudimentary. But I can’t 
tell you how many times I see decimals in charts that should be formatted as 
percentages or no thousandths separators (a pet peeve of mine) or two decimal places 
filled with 0′s because the number didn’t need decimals. 

These newbie mistakes are uncalled for because Excel placed several number 
formatting options front and center in the Number section of the Home tab: 

  

 

More Ribbon Options 

Both PC and Mac offer more number formatting options from the ribbon. All you have to 
do is click the drop-down menu above the icons we just looked at. 
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Date Formatting 

Excel gives you quite a few options to choose from under Number > Date in the Format 
Cells dialog (which, again, you get to by pressing Ctrl-1 or Command-1 on the Mac). But 
I’m fond of the format that looks like Jan 14, which Excel doesn’t offer.  

No worries. Following a few simple principles, you can construct your own formatting 
options. 

We’ll use January 1, 2014 in our examples below: 

m: 1 

mm: 01 

mmm: Jan 

mmmm: January 

d: 1 

dd: 01 
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ddd: Wed (because it fell on a Wednesday) 

dddd: Wednesday 

yy: 14 

yyyy: 2014 

So here are some examples of how you can show Jan 1, 2014: 

Jan 1, 2014: mmm d, yyy (or yyyy) 

Wednesday, January 1, 2014: dddd, mmmm d, yyy 

Wed. 01.01.14: ddd. mm.dd.yy 

Number Formatting 

Using Colors 

Excel gives you a plethora of number formatting options. I wrote a post on how to rock 
them, which you can find here: bit.ly/number-formatting.  

One of those options is to change the color of numbers based on their value. So, instead 
of using parentheses or a negative sign to indicate negative numbers, you could make it 
red. Sometimes I’ll make positive numbers green to match.  

If you want to change your standard number formatting, you need to understand how 
Excel formats these numbers:  

positive number; negative number; 0; text 

So, as you can see in the screenshot below, here’s how that translates in the Format 
Cells dialog. 
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Excel offers a handful of preformatted colors you can use: 

[BLACK] 

[GREEN] 

[RED] 

[BLUE] 

[CYAN] 

[MAGENTA] 

[WHITE] 

[YELLOW] 

Note: These aren’t case sensitive. 
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If you’re a diva and those options are too constricting, Excel offers 56 colors in the form 
of [color X]. I actually find the [green] option too light, so I use [color 10] instead. You can 
find the full spectrum of colors in the helpful chart on this site: bit.ly/all-the-colors.  

The steps to applying number formatting are fairly straightforward. Let’s say, for 
example, you have a list of values you want to convert to percentages. And you want 
positive numbers to be green [color 10] and negative values to be red. Here are the 
steps you would take: 

1. Select the column you want to format. 

2. Pull up the Format Cells dialog (Ctrl/Command-1) and navigate to Number > 
Custom. 

3. In the Type field enter the following formula: 

 
This just tells Excel, in addition to the colors, make the numbers percentages with no 
decimals. If you want one decimal place, just add it to the number, e.g., 0.0%. Two 
decimals, make it two, e.g., 0.00%.  
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If you didn’t want percent, drop the % sign, e.g., 0.0 would translate to something like 
4.7. You can also add things like currency symbols. 

Adding Text to Number Formatting  

Let’s say you don’t want negative signs, parentheses, or colors. Instead, you want positive 
numbers to append “Profit” to a currency value, “Loss” to a negative currency value, and 
“Break Even” (with no number) if it’s 0. 

Your formula would look like this: 

$0″ Profit”;$0″ Loss”;”Break Even” 
Note: You have to include a space inside the quotes, or it’ll look like $4583Loss. No grinding 
on the dance floor please! 

If you look at the formula bar, you can see Excel sees it as a number value, not text. 
Another clue that it’s a number is it’s right-aligned. Text is always left-aligned in Excel. 
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Notes: Cell Formatting 
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Conditional Formatting 
This will be a live demo, but first, a little background … 

Anyone who knows me knows I’m not a fan of tabular data (data in tables). If you want 
your data to be persuasive, it needs to be visual. However, when you’re dealing with 
large data sets that’s not always feasible. For example, when I’m dealing with data from 
webmaster tools or Screaming Frog, there’s just too much data to analyze with charts. 

That’s where conditional formatting comes in handy. Unlike custom cell formatting, 
which is static, conditional formatting is based on — you guessed it — conditions that 
you set. 

Where to Find It 

You can find the Conditional Formatting options on the Home Tab under the Styles 
group (Mac: Home > Format). I can’t possibly cover all the great uses of conditional 
formatting, but I hope to at least whet your appetite and make you aware of what they 
can do. Then you can take these tips and run with them. 
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Notes: Conditional Formatting 
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Templates 

Workbook Templates 

One issue I see a lot in companies and agencies is there’s little (sometimes no) template 
that everyone uses to create dashboards and other Excel documents. The result is everyone 
creates their own charts and graphs using Excel’s [hideous] defaults.  

The solution to this is to use templates. The key to creating a template is to get everything 
in an Excel file you want to be included, including themes, fonts, colors, custom table 
formatting, custom pivot table formatting, custom  text box, your preferred style for title, 
footer, top  row, margin column, chart templates, number of sheets, default sheet names … 
basically the kitchen sink. One of mine looked like this: 

 

 

When you’ve stuffed everything you can get into the suitcase (can you tell I travel a lot?), 
then delete everything you don’t want to show up in every future file from the Excel file. 
Also, make sure none of your columns and rows are weird widths/heights, or they’ll show 
up this way in every Excel file you create from this day forth. 

You can even paste these items into the workbook from other workbooks. You can delete 
them as soon as you drop them in there. Their DNA just has to be left behind. 

Because the processes from here are so different on the PC and Mac, I’ll cover them 
separately. 
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PC 

You’ll want to save your file as an Excel Template (.xltx) from the Save As dialog and set 
the filename as Book.xltx. You’ll need to save it in the XLSTART folder. To get to it, navigate 
to:  

C:\Users\[Your User Name]\AppData\Roaming\Microsoft\Excel\XLSTART 

Pro Tip:  If you don’t see the AppData folder, it’s because this folder is hidden by default. 
You have to first enable Windows Explorer to view hidden items. You can see in the 
screenshot below where to find that option. Just check it, and your AppData folder will 
magically appear. 

 

 

Mac 

You’ll want to save your file as an Excel Template (.xltx) from the Save As dialog and set 
the filename as Workbook.xltx. Then navigate to the folder below and save it there:  

Applications/Microsoft Office 2011/Office/Startup/Excel 

Finally, navigate to the Workbook.xltx file in the Finder, select it and press Command-I to 
open the Get Info window. Under Name & Extension, remove the .xltx  from the filename 
and press Return. (Alternatively, you can just remove it in the Finder.) You’ll get a prompt 
asking if you really want to do that. Just click Remove. Then you can close out of the Get 
Info window. Restart Excel, and your new template will be applied to all new workbooks you 
create. 

Tip for PC Users 

If you want to really dial up the awesome on your workflow, you can save your custom 
table, pivot table, chart, etc. as the default options so that when someone creates, for 
example, a pivot table, your custom pivot table will be applied to the pivot table. Just look 
for the Set As Default option in each of their windows. To set a default pivot table, just 
right-click on your style and chose Set As Default. Here’s what it looks like for the pivot 
table dialog on a PC: 
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As with so many of Excel’s features, this doesn’t seem to be an option on the Mac.  

Chart Templates 

Any chart you create can be saved off as a template. This can save a lot of time because 
the next time you have a data set that would be conducive to that chart, you can just 
choose your template. 

To save a chart as a template on a PC, you would choose Chart Tools > Design > Save As 
Template. On a Mac, the easiest way is to right-click on the chart and choose Save as 
Template. But if you prefer using the Ribbon, go to Charts > Change Chart Type > Other > 
Save as Template. (Like I said, use the contextual menu.) 

This saves your chart in a folder on your hard drive in the following folders:  

PC: C:/Users/[Your User Name]/AppData/Roaming/Microsoft/Templates/Charts 

Mac: Users/[Your User Name]/Library/Application Support/Microsoft/Office/Chart Templates 
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Notes: Templates 
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Formulas 

Functions 

To see a full list of Excel’s built-in functions, check out bit.ly/excel-function-reference.   

Math 

SUM 

Syntax 

SUM(number1,number2, ...) 

 

Notables 

• It would be extremely rare to list cells individually. You almost always reference 
ranges. 

• If you want to include more than one range, hold down the Ctrl/Command key. 
• If you want a sum of a range, you can just enter Alt-= (Mac: Command-Shift-T) 

below or to the right of the range surrounded by white space. 
• If you just need to check your math, no need to run a SUM function. Just select your 

range and look at the sum in the status bar at the bottom of the Excel interface. 
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SUMIF 

Syntax 

SUMIF(range, criteria, [sum_range]) 

 

Notables 

You use the SUMIF function to sum the values in a range that meet criteria that you specify. 

• The	
  criteria	
  can	
  be	
  hardcoded	
  into	
  the	
  function	
  by	
  putting	
  them	
  in	
  quotation	
  marks	
  (e.g.,	
  
“>=50”,	
  “organic”,	
  etc.)	
  or	
  can	
  reference	
  a	
  cell.	
  My	
  preference	
  is	
  to	
  reference	
  cells.	
  The	
  
formulas	
  are	
  easier	
  to	
  interpret	
  and	
  update.	
  You	
  can	
  even	
  get	
  all	
  crazy	
  organized	
  and	
  name	
  
the	
  cell	
  as	
  a	
  named	
  range	
  and	
  reference	
  the	
  named	
  range.	
  

• If	
  the	
  sum_range	
  argument	
  is	
  omitted,	
  Excel	
  adds	
  the	
  cells	
  that	
  are	
  specified	
  in	
  the	
  range	
  
argument	
  (the	
  same	
  cells	
  to	
  which	
  the	
  criteria	
  is	
  applied). 

• You	
  can	
  use	
  Excel’s	
  wildcard	
  characters	
  in	
  the	
  criteria	
  argument	
  for	
  partial	
  matches,	
  e.g.,	
  
=SUMIF(A1:A200,"*shoes*",F1:F200).	
  

• The	
  ?	
  wildcard	
  character	
  is	
  good	
  for	
  any	
  one	
  character;	
  the	
  *	
  allows	
  	
  you	
  to	
  replace	
  any	
  
number	
  of	
  characters	
  (including	
  0).	
  If	
  you	
  want	
  to	
  actually	
  search	
  for	
  either	
  of	
  these	
  
characters	
  (or	
  the	
  tilde),	
  put	
  a	
  tilde	
  character	
  (~)	
  in	
  front.	
  	
  

 

SUMIFS 

Syntax 

SUMIFS(sum_range, criteria_range1, criteria1, 
[criteria_range2, criteria2], ...) 

 

Notables 

• The	
  SUMIFS	
  function	
  is	
  just	
  the	
  SUMIF	
  function	
  but	
  for	
  multiple	
  criteria.	
  	
  	
  
• Where	
  the	
  sum_range	
  is	
  the	
  last	
  argument	
  with	
  the	
  SUMIF	
  function,	
  it’s	
  the	
  first	
  with	
  the	
  

SUMIFS	
  function.	
  	
  
• You	
  can	
  use	
  wildcard	
  characters	
  in	
  the	
  criteria	
  argument	
  for	
  partial	
  matches,	
  e.g.,	
  

=SUMIF(F1:F200,A1:A200,"*shoes*",B1:B200,”>5000”).	
  

 

% Δ  

This is custom formula you will need to use a lot as a marketer. 

=(NEW – OLD)/OLD  OR  
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- or -  

(NEW/OLD) – 1  

 

Logic 

IF 

Syntax 

IF(logical_test, [value_if_true], [value_if_false]) 

 

Notables 

• This is Swiss army knife for marketers. Very important to get this one down. 
• On the PC, you get colored parentheses to help you. And the last parenthesis in the 

formula will be bolded when for a moment as another visual cue that you’ve reached 
the end of your journey. (You’re on your own with the Mac.) 

• If you’re building a complex IF formula, I highly recommend breaking it into several 
lines. This makes writing and interpreting an IF formula easier. Use more than one 
line to get everything to line up. To create the line break in the cell, drag the formula 
bar down (so you can see what you’re doing) and press Alt-Enter (Mac: Control-
Option-Return). Example from a client’s dashboard: 

 

 

Compare it to how it would look without line breaks: 
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IFERROR 

Syntax 

IFERROR(value, value_if_error) 

 

Notables 

• For the value_if_error argument, you could use a string like “N/A” or leave it blank 
by entering two quotation marks with no space in between: “”. 

• With the exception of a strategic use of #N/A errors in creating dynamic charts, I 
avoid error references in my data. Because (wait for it …) they’re ugly. 

• This is typically used as a wrapper for other functions. I use it most with VLOOKUP 
formulas.  

Text 

PROPER 

Syntax 

PROPER(text) 

 

Notables 

• I often use this to fix raw data that is exported as all lowercase — to make it look a 
little more polished. 

• You can use it as a wrapper embedded in other formulas. 
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LOWER 

Syntax 

LOWER(text) 

 

Converts text to lowercase. 

 

CONCATENATE 

Syntax 

CONCATENATE(text1, [text2], ...) 

 

Notables 

• I wrote a post on 18 marketing uses for CONCATENATE: bit.ly/concatenation.  
• I rarely use CONCATENATE. Instead I use the ampersand character ( & ) to 

concatenate. It does the same thing but is less clunky. 
• Excel really needs a JOIN function that allows you to pick a range of cells and 

choose a delimiter like Google Spreadsheets offers. It can be a huge pain to choose 
each cell, enter a comma, rinse and repeat. To dial back the pain level a bit, if you’re 
using the CONCATENATE function, you can choose multiple cells by holding down 
the Ctrl/Command key while you’re choosing the cells you want to concatenate. This 
will automatically enter commas in between arguments. 
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TEXT 

Syntax 

TEXT(value, format_text) 

Notables 

• The TEXT function converts a numeric value to text and lets you specify the display 
formatting by using special format strings.  

• Ex: TEXT(B3,”#,###”) or TEXT(B3,”mm/yy”) or TEXT(B3,” $#,##0.00”) 
• You will use what you learned from the Number Formatting section to build out this 

function. To see more examples, check out Microsoft’s guide: bit.ly/ms-formatting-
guide. Very thorough. 

• Example from the practice Excel doc: 
 

 
 

Note:  I don’t typically use text extraction formulas in dashboards, but it’s really important, 
as marketers to learn how to extract text you want using functions like LEFT, RIGHT, MID, 
LEN, and SEARCH (or  FIND). To watch a tutorial on how I used some of these to pull 
domains out of a list of URLs, check out bit.ly/text-extraction. You can also check out any 
videos on the topic by Bill Jelen or Mike Girvin on YouTube. (They’re my faves and have 
tons of helpful video tutorials.) 
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Date and Time 

DATE 

Syntax 

DATE(year,month,day) 

 

Notables 

• You will need to use this function when working with Google Analytics data a lot. 
This is because both the interface and API spit out dates in this format: 
yearmonthday (20140131). Really useful, huh? I’ve brought this to the team’s 
attention. But until they fix it, you’ll need to use the DATE function to prep the date 
before you can do anything useful with it. 

• If you just need month and year for a chart axis or tabular data, just enter “01” for 
the day. You can get rid of it with custom cell formatting by formatting your values 
as something like mm/yy (covered in the Cell Formatting section). 

Lookup 

VLOOKUP 

Syntax 

VLOOKUP(lookup_value, table_array, col_index_num, 
[range_lookup]) 

 

Notables 

• For the table_array argument, I always name the range rather than enter a range. It 
makes VLOOKUP formulas easier to interpret. To name a range, select the range and 
enter your name in the Name Box (which is due west of the Formula Bar). 

• The VLOOKUP lookup isn’t case sensitive. 
• If you use a VLOOKUP formula in a formatted table, Excel will use structured 

references instead of cell ranges. These will look like [@Column_Heading], e.g., 
[@Visits]. 

• For marketing purposes, the last argument, [range_lookup], will be set to FALSE, 
which means use exact match.  

• You can use 0 instead of FALSE, if you’re lazy efficient like I am. 
• You can use Excel’s wildcard characters in the lookup value. A	
  question	
  mark	
  matches	
  

any	
  single	
  character;	
  an	
  asterisk	
  matches	
  any	
  sequence	
  of	
  characters.	
  If	
  you	
  want	
  to	
  find	
  an	
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actual	
  question	
  mark	
  or	
  asterisk,	
  type	
  a	
  tilde	
  (~)	
  before	
  the	
  character.	
  Learn more about 
wildcards: bit.ly/excel-wildcards.  

• If you have extra spaces in your raw data, they will give you unexpected results in 
your VLOOKUP. So ensure this doesn’t happen, wrap the lookup_value in a TRIM 
function. It would look like this: 
 

VLOOKUP(TRIM(lookup_value), table_array, col_index_num, 
[range_lookup]) 

 
• The lookup_value’s match in the table_array must be in the far-left column for the 

formula to work. If the column you need to perform the lookup against is in a table 
and isn’t the far-left column but is at least to the left of the column with the values 
you want to return, you can create a named range inside the table or just reference 
the range in your lookup formula. 
 

 

 

INDEX 

Syntax 

INDEX(array, row_num, [column_num]) 

 

Notables 

• We will be combining the INDEX function with the COUNT and COUNTA functions to 
create dynamic named ranges, which will result in dynamic charts. 

• Why not just use a formatted table? Because tables can expand but not contract. 
(Lame.) We need our data series and categories in charts to expand and contract. 

• Think of the INDEX function as scooping out a subset of data from a larger data set. 
• It’s much more stable than the OFFSET function to create dynamic ranges. Although 

more people are comfortable with OFFSETs, in a dashboard that’s already a gurgling 
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volcano of data, they can be disastrous. Think of OFFSET as the kid your mom 
warned you to stay away from. 

• You can see examples of how INDEX (as well OFFSET) can be used to create 
dynamic named ranges in the Dynamic Ranges section of the workbook. 

 

OFFSET 

Syntax 

OFFSET(reference, rows, cols, [height], [width]) 

 

Notables 

• See notes for INDEX. 

 

 

Statistical 

COUNT 

Syntax 

COUNT(value1, [value2], ...) 

 

Notables 

• Empty	
  cells,	
  logical	
  values	
  (e.g.,	
  TRUE/FALSE),	
  text,	
  or	
  error	
  values	
  in	
  the	
  array	
  or	
  reference	
  
are	
  not	
  counted. 

• If you want to count logical values, text, or error values, use the COUNTA function. 
• If you want to count only numbers that meet certain criteria, use the COUNTIF or 

COUNTIFS function. You’ll see an example of this in the Dynamic Ranges section. 
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COUNTA 

Syntax 

COUNTA(value1, [value2], ...) 

 

Notables 

• The COUNTA function counts cells containing any type of information, including error 
values and empty text that was hardcoded in using a formula (""). 

• If you want to count only cells that meet certain criteria, use the COUNTIF or 
COUNTIFS function. You’ll see an example of this in the Dynamic Ranges section. 

 

Arrays 

TRANSPOSE 

Syntax 

TRANSPOSE(array) 

 

Notables 

• When data comes out of an API tool, it’s in columns. You can use the TRANSPOSE 
function to flip it on its axis. 

 



82 | P a g e  
 

• Because this is an array function, you need to enter Ctrl-Shift-Enter (Mac: Control-
Shift-Return) after you enter it. 

• The TRANSPOSE function is different from the Paste Special option. You can copy 
any range, move to another area of the workbook (that doesn’t intersect with the 
original data set) and transpose it from the Paste Special dialog.  

 

 

But for a dashboard you need a solution that will transpose your data dynamically. 
That’s what the TRANSPOSE function does.   
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Notes: Functions 
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Relative vs Absolute References 

Theory 

By default, a cell reference is relative. Ergo, when you refer to cell D2 from cell A2, you’re 
actually referring to a cell that is three columns to the right and in the same row (2). A 
formula that contains a relative cell reference updates as you copy it from one cell to 
another. 

If you want to lock down the original cell reference when you copy it, make the cell 
reference absolute by putting a $ sign in front of both the row and the column.  

If you only want to lock down the column, put the $ in front of the column; if you want to 
lock down the row, put the $ in front of the row. Just ask yourself, When I copy this formula 
down and over, do I want any part of it to be locked in place?  If the answer is yes, you 
need the $. 

How to Toggle Through Options 

Press F4 (Mac: Command-T) to switch between the reference types. Just keep toggling until 
you have the one you want. Much easier than entering dollar signs by hand. 

The table in this resource by Microsoft summarizes how a reference type updates if a 
formula containing the reference is copied two cells down and two cells to the right: 
bit.ly/data-lockdown.  

Pro Tip: Even if you have an absolute reference, if the cell you’re referencing is moved to 
another cell, the formula will update. The one exception to this is named ranges. Those 
have to be updated manually. I may or may not have learned that the hard way!  
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Charts 

Tutorial 

I did a comprehensive video tutorial on how to create charts. To view it, navigate to 
bit.ly/chart-tutorial.  

Deconstruct a Chart 

Glossary 

Let’s investigate under the hood of a chart. But first let’s cover some of the terms and what 
they mean: 

Series: Related data points that are plotted in a chart and originate from a larger datasheet. 
Each series in a chart has a unique color. You can plot multiple series in a chart, except for 
pie charts; they only have one series.   

Category: Groupings for data, e.g., months, mediums, quarters, search engines, etc. 

Legend: A group of keys that identifies the patterns and colors that are assigned to each 
data series in a chart. 

Axis: A line bordering the chart plot area used as a frame of reference for measurement. 
The y axis is usually the vertical axis and contains data. The x-axis is usually the horizontal 
axis and contains categories. 

Primary Axis: This is the main axis and should be on the left side of the chart. 

Secondary Axis: This is a supplementary axis that should be on the right side of a chart. It 
should have smaller values, preferably much smaller. For example, bounce rate or 
conversion rate. 

Add New Data  

There are several ways to add new data to a chart. 

1. Right-click chart area and choose Select Data. 
2. Copy/paste it in. 
3. Expand the borders. 

Tips from the Trenches 

• Metrics from Google Analytics (which are anything that can be measured with a 
number) translate into series in charts, and dimensions translate into categories.  
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• How do you know if you need to pivot your data with a pivot table first? Use this as 
your guide: If you just have one dimension you don’t need a pivot table. If you have 
more than one dimension (such as month AND medium or search engine AND 
mobile device category), you need to decide which will become the categories 
(which will typically go along the horizontal axis, unless you’re using a bar chart) and 
which will become the segments for the metrics. 

• If you have multiple dimensions to display in a column chart (for example), you will 
need to decide if you want the columns side by side or stacked. Sometimes it makes 
more sense to place them vis-à-vis. And other times it makes more sense to 
consolidate them into a stacked column. 
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Formatting Tips 

• Consider using muted colors. Having a bunch of bold and/or bright colors in a 
dashboard can add unnecessary noise and look like your data is screaming at the 
viewer. So, when creating branded dashboards, figure out your company’s branded 
colors and dial back the black. In the design world this is called adjusting the tint. 
 

 
 

• Excel places the legend on the right side of most charts, which is the most awkward 
place for it. Don’t be afraid to move it around. You can see in the dashboards I share 
that I align all of mine to the top and right of each chart. 

• Get rid of items you don’t need, such as gridlines. If you need them for visual clarity 
(I often leave them in line charts), make them a light gray. 

• Get rid of the legend if you only have one data series. It’s a statement of the 
obvious. 
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• Use descriptive titles. Don’t use the default title. 
• Sort your data before charting. 

 

 
 

• Avoid 3D charts. Like the plague. 
• If you just have one data series, consider removing all chart junk and using data 

labels to show values. 
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• Excel’s default axes are thick and chewy. I typically thin them out to about half. To 
do this, select the axis you want to thin out, and press Ctrl/Command-1 to pull up 
the formatting options. Then change the Major Unit. However, if you’re using a 
dynamic chart, where these values can change depending on which option a user 
selects, keep the defaults. Customizing the major units will muck up your chart. 
(Based on a true story.) 

• If you’re putting a chart on a dashboard, consider removing the border on the chart 
area to dial back unnecessary noise. 

• Add annotations to point out notable discoveries. I like to go simplistic, like this one 
from the from the Pie Chart section of the workbook: 
 

 
 

• Use a thousandths separator in values greater than 999. 
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• Get decimals out of your axes. You’re a marketer, not a chemist.  
• If you’re demonstrating percentages, format them as such. Don’t leave them as 

decimals. 
• This is my personal preference, but I hate seeing hyphens in lieu of zeroes. I use the 

following number formatting to convert numbers:  
 
Non-Revenue: _(* #,##0_);_(* (#,##0);_(* 0;_(@_) 

Revenue: _($* #,##0_);_($* (#,##0);_($* 0;_(@_) 

 
If the zeroes don’t line up with other numbers in a table, you may need to add  _) 
after the 0 and before the semicolon.  
I keep these saved in my Evernote for quick reference. To learn how to modify the 
standard formatting, check out this post I wrote: bit.ly/zero-formatting.  

• Use text boxes to add annotations. 
• Consider making your chart title dynamic. 
• Simplify large numbers by either using a custom number format (e.g., $#,," M";) 

or axis formatting: 
 

 
 

• Search for dashboards online. Keep a treasure trove of the ones you like, noting 
what elements you like. I use Evernote to store all of mine and refer back to them 
for inspiration.  
 



92 | P a g e  
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Notes: Charts 
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Different Charts for Different Purposes 

Pie Chart 

 

I have to admit I’m not a big fan of pie charts. They make data hard to analyze. But if 
you’re wed to using them, here are a few tips: 

• They can only have one data series, e.g., visits, revenue, goal completions. 
• Make sure each part contributes to the whole. 
• Sort in descending order to make them easier to interpret. 
• Consider adding data labels to them to make them easier to analyze. 

 



96 | P a g e  
 

 
 

•  “Break apart” one element from the chart to make it stand out more. 
 

 
 

• You could also use percentages as the data label. 
• I prefer column or bar charts over pie charts. 
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Column Chart 

This is the chart type I use most. Here are a few tips/notes: 

• Not a good candidate for data with long labels. (Use bar charts instead, where the 
labels can be displayed horizontally. 

• Don’t display axis labels at an angle or (worse) vertically. 
• Great for combination charts. 

 

 
 

• If you’re going to use them for a data set with a time element, simplify the format of 
the time using cell formatting. (Whatever formatting you apply to the data set will 
carry over to the chart.) 
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•  I usually get rid of gridlines altogether with clustered column charts but sometimes 

leave them in with clustered column charts. If I leave them in, I make them really 
light, like you see in the chart above. 

• If you have more than one dimension, such as months and social network in the 
previous chart, you will need to choose between a clustered chart or stacked. 
Personally, I find that the more segments there are, the busier a chart becomes with 
a clustered approach. I lean toward stacked. 

• As mentioned in the Formatting Tips section, if you only have one data series, 
consider getting rid of all distractions (including the vertical axis) and include data 
labels with the columns. I added a subtle border to the columns and made the 
columns a little wider by reducing the gap width.  
 

 
 

Bar Chart 

I am quite partial to the column chart over the bar chart because of the ability to have data 
on a secondary axis (e.g., visits and revenue on the primary axis and conversion rate on the 
secondary). But they still have their place. Here are some examples of when they come in 
handy: 

• If you’re trying to keep your dashboard from getting too tall, bar charts are a good 
option because of their horizontal orientation. 
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• If you include a scorecard (like we have in the upper-left corner of the dashboard), 
you can strip a bar chart down to just the series and align it with the rest of the data 
(provided you have the accompanying values next to it. 
 

 
 

• With most charts in Excel, to sort your series, you need to sort the underlying data 
in descending order. It’s the opposite with bar charts. You need to sort them in 
ascending order.  

Line Chart 

The line chart is my chart du jour for time-based categories. Here are a few things to keep 
in mind: 

• Make sure that the line width is adequate. Thin lines can be hard on the eyes and 
don’t print well. 

• I almost always keep horizontal gridlines but make them a light gray. 
• Markers add noise and cause the viewer’s eyes to trip. Be careful to make sure you 

actually need them. 
• Stacked line charts are a usability disaster. They don’t look connected. If you have a 

chart with two dimensions and one of them is time based, consider using the 
stacked area chart. 
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• If your data doesn’t have a time element and uses categories instead, don’t use a 
line chart. Line and area charts communicate that the data is sequential, with some 
data points preceding a particular data point and other data points following it in a 
continuum.  

 

Area Chart 

Basically, I only use the area chart if I have data with a time element and need it to be 
stacked. So for the line chart, I never use the stacked option, and for the area chart, I never 
use the clustered option.  

A few other notes: 

• A clustered area chart works if one series is a subset of another. For example, if 
you’re plotting email delivery vs. opens. Opened emails is a subset of those 
delivered. If one isn’t a subset of another, data gets obscured, as you can see 
below. 

 

 

• The stacked area chart is a great way to show how each series (e.g., marketing 
channels, device category for mobile, social network, etc.) contributed over time. 
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• Try wherever possible to stack in order of size. To do this, select the data and move 
the series up and down in the stacking order. 
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• Consider thinning out the horizontal axis. 
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Scatter Chart 

Scatter charts are used to test correlations by plotting two groups of numbers as one series 
of xy coordinates. For example, you may want to see if there is a positive correlation 
between ad placement and revenue. Or between bounce rate and conversion rate.  

 

A few notes: 

• When using the API, you will typically pick two metrics and a time-based dimension 
over a fairly long period of time (to get a good sample). No need to apply a sort. 
Your query (in Excellent Analytics) might look something like this: 
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• When creating the chart, you only need to select the two columns with the metrics. 
You don’t select the dimension (category) column. Just select both headings and 
press Ctrl/Command-Shift-Down Arrow to slide down to the bottom of the data set. 

• When choosing the time-based metric, I am a bit partial toward the week dimension. 
In most cases, the month dimension tends to not be granular enough, and the date 
dimension tends to make the chart too dense. I’m even worse with porridge. It’s 
ridiculous. 

• You can add a trendline to your scatter chart to aid in seeing the trend of your data.  
• If the data points huddle around a trendline that moves up and to the right, there is 

a positive correlation between the two metrics. If they are concentrated around a 
trendline that moves down and to the right, there is a negative correlation between 
the two, meaning if one goes up, the other goes down. 

• Calculate the correlation coefficient to see how strong the correlation is. The function 
syntax looks like this: CORREL(array1,array2 …). The closer the number is 

to 1 the stronger the positive correlation is; the closer it is to -1, the stronger the 
negative correlation is. 

• Put the metric you want to analyze in the left column. I think of it this way: “What 
happens to [left column metric] when [right column metric] [increases or 
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decreases]?” So in this example, the question I’m trying to answer is: What happens 
to bounce rate when page load time increases?  
 

 
 

• In our example, there is a slight positive correlation, meaning more visits bounce 
when they take longer to load. But a .27 correlation coefficient may not be 
compelling enough to invest the resources into optimizing page load times. 

• Always add axis titles. When you add titles, everything tends to look really cramped. 
Don’t be afraid to adjust the chart area. The easiest way to select the whole area 
(and not just one gridline) is to select the top horizontal gridline. 

• I will typically add vertical gridlines in addition to the horizontal gridlines but make 
them light and dashed. 
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Notes: Charts for Different Purposes 
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Pivot Tables  
Being able to manipulate data with a pivot table is a critical skill for marketers. The reason is 
we’re inundated with large data sets at every turn, and pivot tables give you the flexibility to 
easily move data around to investigate relationships between data and make actionable 
conclusions. 

When you’re trying to find correlations and causal relationships anything short of a pivot 
table is going to fall short. And trust me … They look scary at first, but they’re so easy to 
use once you learn the underpinning logic that powers them. 

Prepare the Data 

Before you can create the pivot table, there are a few things you need to do to ensure your 
pivot table doesn’t stroke out on you later. 

1. Set your table up in tabular format. 

Formatting your data as a table is a good first step, although it doesn’t always work well 
for dashboards. But basically you need to follow the structure of a database, where your 
data only includes column headings. You can’t have row headings, like this table: 

 
 

2.  Organize your columns by buckets, not individual values. 

This is probably the hardest concept to grasp when you’re first starting with pivot tables. 
So, for example, if you wanted to see visits to a site broken down by month and medium, 
you might be tempted to create a column for each medium (organic, PPC, social, email, 
etc.) and each month. This would be incorrect and will cause you all manner of aggravation 
when you go to pivot the data. 

Your column headings would need to be the broader buckets: Visits, Medium, and Month. 

Here’s where it gets a bit tricky … 

Let’s say you have visit data for two years, and you want to compare year-over-year data — 
in other words, visits for 2013 compared to the same months in 2012. Then, you would 
need to have a column for each year. If you think about what we learned in the section on 
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deconstructing a chart it makes sense. You need each year to be its own data series, 
whereas if you just had a year column, both years would be a part of the same series.  

3.  Avoid blank columns, rows, and cells. 

To ensure you don’t have any blank rows and columns, make sure the bottom-right corner 
of your table is flushed up against the data. Also, blank cells can wreak havoc in your data 
and even cause Excel to think your whole column of numbers is text, which will limit your 
filtering options down the road. 

To hunt down these blanks in your data, click inside your table, press Ctrl-A (Mac: 
Command-A) to select just the data inside your table, then Ctrl-G (Mac: Control-G) to pull 
up the Go To dialog. Click the Special button, choose Blanks, and click OK. This will select all 
the blank cells in your data. Then enter a 0 and, without clicking anything, enter the 
number 0 and Ctrl-Enter (Mac: Command-Return). This will enter the 0 inside all of the 
blank cells, though they make show up as hyphens if you’re using the default number 
formatting with thousandths separators. 

 

Pivot Table Tutorials 

This is going to be a live demo. But if you want to refresh your understanding later on, 
check out these resources I’ve created: 

• My video walkthrough bit.ly/pt-video 
• My comprehensive tutorial on the Search Engine Land site: bit.ly/sel-pt-tutorial 
• My tutorial on how to keep column widths when you refresh your pivot table: 

bit.ly/pt-annoyance 
• My tutorial on how to create pivot table-friendly reports in the Google Analytics 

interface: bit.ly/pt-reports  
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Notes: Pivot Tables 
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Sparklines 
Unlike charts on an Excel worksheet, sparklines are not objects. A sparkline is actually a tiny 
chart in the background of a cell. Because	
  of	
  this,	
  you	
  can	
  actually	
  enter	
  text	
  in	
  a	
  cell	
  and	
  use	
  a	
  
sparkline	
  as	
  its	
  background,	
  although	
  in	
  most	
  cases	
  I	
  wouldn’t	
  recommend	
  doing	
  this.	
  	
  

The	
  benefit	
  of	
  sparklines	
  is	
  the	
  ability	
  to	
  spot	
  trends	
  in	
  your	
  data	
  at	
  a	
  glance	
  without	
  taking	
  up	
  a	
  lot	
  
of	
  real	
  estate.	
  

Create Sparklines 

1. Select an empty cell or range you want to insert your sparkline(s). 
2. Go to Insert > Sparklines (Mac: Charts > Insert Sparklines) and choose the type of 

sparkline that you want to create. You can choose a line, column, or win/loss. 
3. In the Create Sparklines dialog, choose your data range. 

 

 
 

4. Customize your sparklines. 
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Notes: Sparklines 
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Analytics Canvas 

Intro 
This will be a live demo because there’s just too much to put in this manual, and the tool 
updates pretty frequently. So screenshots could prove to be more frustrating than helpful. 

That said, it will help you significantly to understand the underpinning logic behind Analytics 
Canvas. It is, hands down, my favorite Google Analytics API tool (at the time of writing).  

Here are a few reasons it’s a superior tool to Excellent Analytics: 

• It stays up to date with changes Google Analytics, which is no small task. 
• It allows you to access the Multi-Channel Funnel (MCF) Reporting API. This is, in my 

opinion, the most important update to Google Analytics since Google took over the 
tool. As I mentioned in the section on the Multi-Channel Funnels report, reporting on 
last-click conversions alone is a travesty and causes marketing departments to make 
decisions on fatally flawed data. Think of it this way: How fair would it be to have a 
football team and only pay players who run the ball into the end zone? Pretty 
ridiculous, right? That’s what we’re doing with reporting on last-click conversions 
only. So if you’re tracking revenue at all (in goal conversions or ecommerce), you 
should be including MCF reports. 

• It has social metrics and dimensions. Excellent Analytics doesn’t. 
• It allows you to pull in data from Google Spreadsheets, databases, Excel (or text) 

files on your network, or Bing Ads. You can take this data and marry it to your 
analytics data. It’s also the only tool to date to allow you to import data from Google 
Spreadsheets without having to make the data public.  

• It has an amazing ability to get around sampling for large sites. 
• Imagine Analytics Canvas as a conveyer belt, where you start with raw data (just as 

you do with Excellent Analytics) but then clean it up using data blocks that are 
connected. Ultimately, your final block will be an export block. 

Basic Workflow 
There are a few basic steps you take with Analytics Canvas: 

1. Create an Excel doc to use as your template. I create a Raw Data sheet and export 
all of my raw data there. 

2. Run your first query, giving it a name. 
3. Set your master date range. (This will be the default, but you can choose custom 

date ranges for individual queries.) 
4. Use data blocks to clean up the data and manipulate it. 
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5. Add an export block. 
6. Set up the workbook you’ll use for the template and report folder. I also add year 

and month to the report file since I do monthly reporting. This gives each month’s 
report a unique title. You only have to set this up for the first query. All others will 
use that same template and reports folder. 

7. Tell Analytics Canvas where you want to export that data to using the picker. I leave 
extra columns between exports to give myself extra room. 

8. Write the data to the template. 
9. Rinse and repeat (except for step 6). 
10. After you’ve written all the data you need to the template, build out your 

visualizations in the template file. 
11. Run a test with another date range (or another site if you’re creating one template 

for multiple sites). 
12. If all passes muster, delete all of the data from the template. (Under the Outputs 

tab, right-click the workbook and choose Remove All Data from Template.) This will 
remove the data but keep the framework. It’s important, once you’ve build the 
template, to keep data out of it. Otherwise, data from the template could end up in 
the reports. If you need to change something in the template and need data back in 
there, right-click on the export file again under Outputs and choose Write All Data to 
Template. Just remember to delete it when you’re finished tinkering. 

13. Run a report by clicking the green play button in the upper-left corner of the 
interface.  

Help Files 
To get to Analytics Canvas’ help files go to: bit.ly/ac-help.  

They also have a Quick Start Guide: bit.ly/ac-quick-start.  

But the best way to gain mastery of Analytics Canvas is to through the canvas I provide in 
the template I provide. I’ve included as many annotations as I could shoehorn into the 
space allowed. Just check out the blocks to see how I used them to clean up the data and 
labels, filter, sort, pivot, join, etc. my data. 

Important Formulas 
In the Marketing Channel canvas I used a number of formulas to use in segmentation blocks 
for all mediums in Analytics Canvas. Check these to see if they work for your site. If they 
don’t, you’ll need to modify them for your canvas. They’re in the blocks called Define 
Medium for both block groups on that canvas. 

Organic: CONTAINS([Original.Medium],"email","internal","marketo") 
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Direct: CONTAINS([Original.Medium],"(none)") 

Referral (excludes social): AND([Original.Medium]="referral",[Original.socialNetwork]="(not 
set)") 

Social: OR(CONTAINS([Original.Medium],"social","social-
media","sm","twitter","twitter.com","facebook","facebook.com","fb","youtube","youtube.co
m","buffer","socialflow"),AND([Original.Medium]="referral",[Original.socialNetwork]<>"(not 
set)")) 

Email: CONTAINS([Original.Medium],"email","internal","marketo") 

CPC: CONTAINS([Original.Medium],"cpc","retargeting","ppc","paid") 

Affiliate: CONTAINS([Original.Medium],"affiliate","partner","cpa") 

Feed: CONTAINS([Original.Medium],"feed") 

Banner: CONTAINS([Original.Medium],"banner","display") 

Necessary Data Updates 
Any block that needs to be updated by you the first time you apply it to your site will be 
prepended with UPDATE. Example: 
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Notes: Analytics Canvas 
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Advanced Excel 

Creating a Navigation Bar 
Although most dashboards should be kept to one page, there are instances where you 
might want to have a dashboard span multiple sheets. For example, you might control 
different websites and want to consolidate them into one workbook but have separate 
worksheets for each. Or you might want to have different dashboards for different divisions 
in your company: IT, Marketing, Finance, Etc.  

Just keep in mind that if you separate your dashboard into different worksheets, your 
workbook can become large very quickly. If you start getting too much lag in your 
workbook, you might need to separate them into different workbooks. 

This will be a live demo. 
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Notes: Navigation Bar 
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Pivot Charts 
This will be a live demo, but you can watch this video I did on the topic, if you want to 
brush up later: bit.ly/pivot-chart-tutorial.  

Caveat:  Pivot charts are, sadly, PC swim only. It’s utterly baffling but true. However, you 
can create static charts from pivot tables on a Mac. You just have to avoid total columns 
and rows. Either turn them off in your pivot table or don’t include them when you select 
your data. 
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Notes: Pivot Chart 
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Dynamic Charts 
This will be a live demo. But I’m including links to resources for you to freshen up on if you 
need to review later. There are also directions in the practice workbook, as well as plenty of 
resources online. 

Combo Box 

Here’s my video tutorial on how to use a combo box: bit.ly/combo-box-chart.  

Option Buttons 

Here’s my video tutorial on how to use option buttons:  bit.ly/option-button-chart.  

Scrollbar 

Here’s my video tutorial on how to use a scrollbar: bit.ly/scrollbar-chart.  

Check Boxes 

I haven’t done a tutorial on this, but it’s a variation on a theme from the others. And there’s 
one in the sample dashboards. 

Combination 

Here’s my tutorial on how to create my beloved combination charts: bit.ly/combination-
chart.  
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Notes: Dynamic Charts 
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Dynamic Ranges 

When You Need Them 

As I talked about in the section on building formatted tables, when you format your raw 
data set as a table, if you add new rows below the data or columns to the right, the table’s 
borders will dynamically expand to include the data. A huge benefit is that if you’ve built a 
chart off of data in a table, when the table expands, the chart will also update with the new 
data. It’s magical and makes me a little weepy. 

However … (You had to know that was coming.) 

What Microsoft overlooked (imo) was what if the data doesn’t expand? What if it shrinks? 
Wouldn’t it be great if tables shrunk too? Yeah!  

But they don’t.  

<stab stab stab> 

This is a huge liability in dashboards because the number of rows in your data set could 
vary (sometimes wildly) from month to month. And because tables don’t shrink, you’re left 
pretty high and dry.  

That’s why you need to learn how to create dynamic named ranges and build charts off of 
them. 

Tutorial 

100-Foot View 

Before we get into the weeds, let’s pull back a bit and get the big picture. So Excel lets you 
name any range of data, even if it’s a single cell. You just select it and enter the name into 
the Name Box to the left of the Formula Bar in any tab.  

There are a few naming rules (because it’s Microsoft, after all): The first character must be 
a letter, underscore (_), or backslash (\). Remaining characters in the name can be letters, 
numbers, periods, and underscore characters.  

So it’s pretty painless to create a simple, static named range. But with a dashboard you 
need to create named ranges for each individual data series and your category column that 
will dynamically update if the underlying data set expands or contracts.  

Important First Step 

Go ahead and create your chart from the static range. After you build out a named range 
for each of the series and the categories, you’ll lift the hood of the chart (via Select Data) 
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and replace the static ranges with named range references (not the formulas, just the 
names you gave each of them). 

Formula Options 

To do this, we’ll need to use one of two functions: INDEX or OFFSET. Most resources 
promote the use of the OFFSET function. However, the OFFSET function is volatile because 
it recalculates any time there is a change in your workbook, which can eat up critical 
resources when you’re building (or using) a reporting dashboard. 

Let’s look at what these functions actually do, and you can decide for yourself: 

OFFSET 

As we covered in the Functions section of the manual, here is the syntax: 

OFFSET(reference, rows, cols, [height], [width]) 

All this says is, “Excel, I want you to start in cell A and go down X number of rows. To 
figure out how many rows to go down, count only the cells in the single-column (or row) 
range I give that contains data.”  
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Let’s break this down (in super simple terms): 

reference:  The first cell of your dynamic range. All ranges referenced in a named range 
need to be absolute, including single-cell ranges.  

rows: How many rows to move down before you start counting the cells in your range. 
Since we’re going to start counting at BF8, and therefore, don’t need to move down any 
rows, we can skip this by entering a comma (even though it’s technically not an optional 
argument). 

columns:  How many columns to move over before you start counting the cells in your 
range. Again, since we’re going to start counting at BF8, we can skip this by entering a 
comma. 

height:  How many cells we want to count. Since this number is going to vary depending on 
the data pull for each time period, we’re going to use the COUNT function to count cells 
with numbers in them. (If these were non-numerical values, such as mediums, we’d use 
COUNTA, but COUNTA will work for numerical values also.) In the range for the COUNT 
function, just make sure you give yourself enough room to expand. But I don’t recommend 
using an entire column as this is computationally intensive. 

Pro Tip: Because I don’t like surprises and hate troubleshooting formulas that break, I add a 
light fill to cells covered by a formula. This way I can easily see if my data has overextended 
its borders and adjust the formula. 

 

INDEX 

The INDEX function is much more stable than the OFFSET function. Like I said earlier, 
because dashboards can already be large files, I try to be as sparing as possible with Excel’s 
resources. With the INDEX approach, we’re going to build a range by referencing the first 
cell in the range and then using the INDEX function with COUNT/COUNTA to figure out the 
last cell in the array that has a value in it. Because it’s the INDEX function, it will return a 
reference to the cell.  

We can see this if we select the entire INDEX formula and press F9 (Mac: Command-=) to 
convert the formula to an array. It returns 3223, which is the value in the last cell in the 
non-blank range of cells. Perfect. 
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So let’s see what that looks like under the hood: 

 

 

Let’s break this down (in super simple terms): 

array: A range of cells. Just as we did with the OFFSET approach, give yourself room for 
your data to expand without going crazy. 

row_num: The number of rows we need to go down to get the range we want  

column_num:  Irrelevant since we only have one column. 

Tips 

• Write your formula in a cell, so you get the ToolTip to guide you. If you write it in 
the Name Manager, you don’t get any tips. 

• Be strategic in naming your ranges to keep named ranges together. If you have a 
bunch of named ranges in a dashboard, you don’t want to have to search for each 
one. If I want to keep them in a particular order, I’ll even include numbers in the 
name. 
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• If you have formulas in a range, you can’t use COUNTA. You can use COUNT 
because COUNT ignores formulas, but COUNTA includes them. The COUNTA 
function counts cells containing any type of information, including error values and 
empty text (“”). For example, if the range contains a formula that returns an empty 
string(“”), the COUNTA function counts that value. 
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• If you have cells with formulas and you want to only count the cells that have actual 
values, you’ll need to use COUNTIF. In the example above, this formula returns just 
the cells that have text in them: 
 
=$L$8:INDEX($L$8:$L$28,COUNTIF($L$8:$L$28,"?*")) 
 
The ?* are wildcard characters. Together they say, “Excel, count the cell if there’s at 
least one character in the cell.” 

• To test a dynamic range, open up the Name Manager by pressing Ctrl-F (Mac: fn-
Command-F3) and select anywhere in the Refers to field. If your formula is working 
properly, you’ll see marching ants around your selection. 
 

 
 

• If my formula returns the marching ants around the data I want to pull into my 
chart, then I close out of the Name Manager and add a new row to that data range. 
If it’s working properly, it will pull in the new value/row. 
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• You could build out each of the formulas individually, but who has time for that? I’m 
always looking for the most efficient solution. So what I do is copy my first formula 
into Word and use Find/Replace to update formula. Although it seems like you’d 
have to, you don’t have to close out of any menus. 
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Update Chart 

1. Right-click inside the chart area and choose Select Data. 
2. Select the series item you want to update and click the Edit button. 

 

 
 

3. In the Series values field, carefully select just the cell reference (start after the 
exclamation mark), press Ctrl-F3 (Mac: Control-L) to pull up the Paste Name dialog, 
and double-click the name you want to insert it. 
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4. You don’t need to update the series name. If you select it, you’ll see it just points to 
the column heading, which is exactly what you want. 

5. After updating all of your series, do the same thing for the categories. 
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Notes: Dynamic Named Ranges 
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Learn Even More Dashboard Skills 
The best course I’ve taken on how to create dashboards in the one done by My Online 
Training Hub. It’s not specific to marketing, but you can apply the techniques to your new 
dashboards. Her skills are spot on, and her Australian accent makes listening a pleasure. 
She also provides Excel workbooks for you to poke around in. (That’s the best way to 
learn.) 

They’ve offered attendees a 20% discount until March 11 (11pm EST). Just get the 
discount, go to bitly.com/more-sexy-dashboards. I still refer back to it when I’m stuck on 
something.  


